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Thermal Enclosure System

Functional Simulation

USER'S MANUAL

ABSTRACT

A form and function simulation of the thermal enclosure system (TIES) for a

microgravity protein crystal growth experiment has been developed as part of an

investigation of the benefits and limitations of intravehicular telerobotics to aid in

microgravity science and production. A user can specify the time, temperature, and

sample rate profile for a given experiment, and menu options and status are

presented on an LCD display. This report describes the features and operational
procedures for the functional simulation.



1. INTRODUCTION

NASA Langley Research Center is conducting research on benefits and limitations

of the application of telerobotics to support microgravity science and production.

The use of telerobotics can potentially increase scientific operations during

tuunarmed periods and assist astronauts with routine tasks during man-tended

periods. Methods for interactive monitoring and control of space experiments wiIl

be developed, to increase the experimenter's ability to interact with the flight system

from the ground, and enhance onboard system sensing and task capability.

The Intravehicular Automation and Robotics (IVAR) laboratory will be used to

develop and demonstrate the teclmology and telerobotic teclmiques needed to

minimize onboard htunan resources for experiment operation and monitoring, and to
provide the experimenter on the ground a more direct role in the control and error

recovery for his experiment. This will be accomplished by application of

knowledge-based expert system techifiques for monitoring processes, diagnosis of

problems and system errors, and support for the experimenter or operator in

recovering. Full-size lnockups of selected laboratory experiments will be developed
for the IVAR testbed, which contains a full-size mockalp of a space station

laboratory module with an internal telerobotic logistics system. Several full size

mockups of selected laboratory experiments will be developed mad evaluated in the
IVAR testbed.

The first task is a protein crystal growth experiment, where fluids are mixed and

crystals are grown inside a thermal enclosure system (TES). The flight TES was

designed by Space hadustries, Inc. for specific use within the mid-deck of the space

shuttle. Space Industries also developed the full size mockup for the IVAR

laboratory. The mockup is designed to operate similarly to the flight system with

respect to controls and displays. The following sections describe the capabilities of
the thermal enclosure system mockup mad its associated menu-driven software
control.
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2. Description of Flight Thermal Enclosure System

The flight thermal enclosure system was designed to provide a stable thermal

environment for space related experiments. The TES was designled by Space

Industries, Inc. for specific use in the mid-deck of the Space Shuttle. The TES

cavity is hermetically sealed and can be used to service experiments such as

materials solidification and protein crystal growth. Programmed timelines coxmnand

the TES to change temperature and to collect temperature data at specified intervals.

An experimenter may also command the flight TES with the four-button keypad and

view software status tlu'ough a four line forty character LCD display.
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3. Operation of Simulated TES

The TES mockup operates through an 80535 microprocessor. The microprocessor
sends control and data information to a two-line forty character LCD. A keypad is

also provided. Four momentary switches (buttons) serve as input devices to the

microprocessor. The buttons are numbered from one to four from left to right,
respectively. Figure 3.1 displays the TES mockup interface.

[::: ::::: :::n i : n ......................................,_w'+++++_!_._+++m++_m:+++_mmm+_m:m!m+++m++!++m'_-++Tits Mocku0 m_m!+_!+!m!+!%.. _.......................................

+m+'+I

Figure 3.1. TES mockup interface

Software flow of the TES is menu driven. The mockup software is similar to the

flight TES software, except that there is no interaction between the physical thermal

electric devices (TEDs), the thermistors, mad the microprocessor. The following
sections describe each menu of the TES software.

3.1 Display Logo

Once the TES is powered, the program initializes the LCD by selecting the 5X7 dot

by 8 bit function set and turning the display on. The microprocessor then outputs
the TES Display Logo to the LCD. The logo is designed to shift left and

wrap-around the display. Figure 3.2 shows the TES Display Logo. A user may exit
the display logo by selecting any of the four buttons.

+ii_+m+mm+mmm+m+m++m++mmm++++TESMockup ................................!!titbit+++++t+t [+++!++!++|tt++tt+++!t+mltq!q::::;;:::: ::: :::: :::: :..................................... : ,::::::::::::

_ffL;4-ff;i+7++;2_+++++++.++;++_+++++f .................................... ;22_2:;::;;+..7;;.;-..;..;..,..........,+;.,_++++++.+.....++..;; .............. ++.,..++++++++
t_+++++++t++N+_'+_++++_+_++..+_+++'++_..F_++_+_'+'._++:+_+i!_++_+'+++'++!++._++'++_'+'++++tt+_+'''t++'_+++++!'+'+NtiN+''+N_+++++t+t'_++'++.:++'++_++_k_+k_++_i|''++|+

::::::;::::::::::::::::::::::iitiiitt_ti_i_ttliir._,l:.N__.!itI,+iit , t ! i •

;............................. i, iilili lili liill ,;; ill lI;, il: _+ ;i-_;,l i il'_l;:, illl;l lIt ill ill ill Ill::: Ill:: iill 1:1::1ill Ill: :: If.,::: il 1,1i lii ::111,.l| :i: ,%*'l: I i,i,if,It,ll, (, ,,,,;,|I

itpt';m'll'i lllti: +iil

Figure 3.2. TES Display Logo
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3.2 Main Menu

The TES Main Menu (Figure 3.3) is the base menu for thermal enclosure system

operations. Button #1 selects the Set Menu, #2 selects the Program Menu, #3

selects the Utility Menu, and #4 activates the Display Logo. The Set Menu allows

the user to set current TES variables. The Program Menu allows the user to view,

edit, and delete timeline programs. The Utility Menu provides system status and an

option for locking or unlocking the keypad.

!!i_!!!i!!!!!!!!_!!!!_!!!-:_!!!!!!!!!!!!!!!!!!!!!!!!!!!!iii!!li!i!!!iii!TES Mockup '"":=;"":'_**_*:_""":*'::":'"**:::*:'=::'_"':*''_[._.L.L!!!!!!!-!!!!!.!!!!!!.!!,,!!L!..'......L..!............................

::: :: : :: " : I :

: * 1 ..................................... _ I_:I :_11111;:l _ll iII [1: ::1111 Ill :_:I_;111 III Ill I

_.i_i_:::::i:_ F_._,_R:_i_/l_l)_._'_'"'"":!:'-'!'"!!I'.'!E,*m_:,_!!!:,*._..: .............. ::::::::::::::::::::::::: i i N

Figure 3.3. TES Main Menu

3.3 Set Menu

The Set Menu (Figure 3.4) allows the user to select tlu'ee TES parameters to change

Button #1 selects the Set Temperature Menu, #2 selects the Set Thermistors Menu,

#3 selects the Set Sample Rate Menu, and #4 returns the operator to the Main
Menu.

,=_ ............................................ TES Hookup ....................
...................................... : :::::::,.:1

:::::|,,,,,,: ...........................................

NN N
Figure 3.4. Set Menu



3.3.1 Set Temperature Menu

The Set Temperature Menu (Figure 3.5) allows the user to hlcrement or decrement

the current temperature. An option (toggle X/.X) is available for the user to select

the increlnent/decrelnent factor. If'X' is selected, the microprocessor increments or
decrement by one degree (1). If'.X' is selected, the microprocessor increments or

decrements by point one degrees (. 1). When the TES mockup is reset, the X factor

(1 degree) is selected by default. Within the Set Temperature Menu, the ctu'rent

temperature is displayed to the far right of the second line of the LCD. Button # 1

increments the temperature, #2 decrements the temperature, #3 toggles the
increment/decrement factor, and #4 returns Back to the Set Menu.

_! ..............!........_........_.,_! TESMOCkUp _ ............. !:=:_2!:_!!!!_!_!_!!_iiiii!!iiii.!!!!!!!!!!!!!i!iiiii!!

;;; ,_. _._,_._._:;"_iN _ _ _,'_ .............................................................................

........... ;.h_.,...x;...; ...................... _,,,.::_'.:,:. _;...;;::;::::::::_::;::::::::_:iN_ii _ii _ _,_ni .. li. l.iiiii" l|i i|! i|ii" iiiiii i;tili.,"i_. t..,

mNNN
Figure 3.5. Set Temperature Menu

3.3.2 Set Thermistors Menu

The Set Thermistors Menu (Figure 3.6) allows the user to activate several of the

thermistors. Button #1 selects the next thermistor to activate. The thermistors are

numbered from #1 to #10. Once thermistor #10 is reached, the system will cycle to

thennistor# 1. Button #2 toggles to activates ('ON') or deactivate ('OFF') the current
therlnistor. All flaermistors are deactivated at reset. The current thermistor number

is displayed in the middle of flae first line of the LCD. The thennistor status is

displayed to the far right of the same line. Button #4 return the user Back to the Set
Menu.
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Figure 3.6. Set Thermistors Menu

3.3.3 Set Sample Rate Menu

The Set Sample Rate Menu (Figure 3.7) allows the user to increment or decrement

how often (in minutes) to sample the thermistors. When the TES mockup is

initialized, the default sample time is set to 10 (1 sample every 10 minutes). The
maximum sample time is 999 minutes (equivalent to 1 sample every 16 hours and 39

minutes). The LCD displays the current sample time to the far right of the second

line. Button #1 increments the sample thne by 1, #2 decrements the sample time by
1 minute, and #4 returns the user Back to the Set Menu.

•-" ::::::,: .::,:-,,,1: "-" : : :: : :,:| ......... lt']............. |" ::::::::::::::::::::::::::::::::::::: : ::::: :::: .." ......I :. :.:;::.. 1:::. ::;::::..::::, 1:..::.::::.: :..:._...m:,..::+..m!.mmm!!mmmmmmm:m!:!:....._..TE$ Mockup 1...............

,..,,,.
ili,,, .if:

Figure 3.7. Set Sample Rate Menu

7



3.4 Program Menu

The Program Menu (Figure 3.8) allows the user to view, edit, mid delete thneline
programs. Section 2.4.1 explains the purpose madfeatures of a timeline program.
The user may also halt execution of a currently rumaingtimeline progrmn. Button #1
selects the View Menu, #2 selects the Run/Pause Menu, #3 deletes the current
timeline program, and #4 rettmls the operator to the Main Menu.

NNNN
___l_

Figure 3.8. Progrmn Menu

3.4.1 View Menu

The View Menu (Figure 3.9) allows the user to view or edit a timeline sequence.

The top line of the LCD displays four parameters of the timeline sequence. The

parameters are sequence nmnber, time value, temperature setting, mad sample rate

setting, respectively. Button #1 increments the tilneline sequence by simply
displaying the timeline parameters as the sequence number increases from one to

ten. If the user selects Button #1 again when the sequence displays the tenth line of

parameter values, the sequence starts over, that is, displaying sequence one

parameter values. The user may define a total of ten sequences per timeline.

I__i_ .._ i...._i.._L.L_...IL.i!iNiiiii!iiii_iI_IN!!_%!!!!!!!!!!!!!!!!!_!!!!!!!!!!!!!N!!!I!

Figure 3.9. View Menu



Figure 3.10 displays a timeline sequence. The timeline is a user progrmnmable
feature that selectshow long the user wants a particular protein crystal solution to
be exposed to a desired temperature. The flight TES contained a data logging

system which collected thermistor data at the specified sample rate in the sequence
timeline.

SEQ TIME TEMP RATE
O0 05:30 030.0 10

O1 02:15 100.0 30

02 01:00 300.0 05

03 00:00 000.0 O0

04 00:00 000.0 O0

Figure 3.10. Timeline Sequence Segment

The following is an explanation of the timeline segment (Figure 3.10). Once the

user has started a timeline from the Program Menu, the program initializes to the

#00 index. For a total of 5 hours and 30 minutes the TES system will mahatain a

temperature of 30 degrees Celsius. During this time interval, the system captures

data from the thermistors (selected in the Set Thermistors Menu) and records 1

smnple every I0 minutes. After 5 hours and 30 minutes, the system changes the

internal temperature to 100 degrees Celsius and records the temperature data at a

rate of 1 sample every 30 minutes. And after 2 hours and 15 minutes, the system

changes the temperature to 300 degrees Celsius for one hour, recording 1 sample
every 5 minutes.

The following is a list of minimum and maximum values for each timeline

parameter:

parameter minimum maximum

sequence number
time value

temperature

sample rate

1 10

0 minutes 99 hours mad 59 minutes

(4 days 3 hours and 59 minutes)

0 degrees Celsius 999.9 degrees Celsius

0 samples per minute 1 sample per 999 minutes

(equivalent to 1 smnple every

16 hours mad 39 minutes)



Button #2 of the View Menu decrements the timeline program. Button #3 selects

the Edit Menu option, while Button #4 returns the user Back to the Program Menu.

3.4.2 Edit Menu

The Edit Menu (Figtu'e 3.11) allows the user to chm_ge the timeline variables. The

first line of the LCD displays the current line of the timeline sequence. The second
line displays the timeline variable to change. Button #1 increments the current

variable, #2 decrements the current variable, #3 toggles the temperature factor

(either 1 or. 1), and #4 sequences the variables. Once in the Edit Menu, time will be

the initial variable displayed. Button #4 pressed once will change the variable to the

temperature setting. Pressed once more, Button #4 will change the variable to the
smnple rate setting. If Button #4 is pressed once more, the user will be returned

Back to the View Menu. When a variable is changed, its new value is displayed on
the first line of the LCDI

: -,n ....... m •

',::I_L"ffP.!,:L:;,_'.,.,.;,L_N..._!ff_._ff!]_|n.:.:!._]]][_!]E_ 1"[_ _O_U_ ..........................................."_'!_;;!I|[_[L"|:-H-_I!IHLqL"|'HH!_!!:Iq! mml_:n;n:_;..

_-:.:.:-v._Nffi_-_-,:f_ii, _ ..............................................................................................................

Figure 3.11. Edit Menu

3.4.3 Run/Pause Menu

The Rma/Pause Menu (Figure 3.12) allows the user to execute or pause the timeline

sequence. On the right side of the second line of the LCD, the system displays the
current status of the system, that is, 'RUNNING' or 'PAUSED'. Button # 1 starts the

system rulming or continues from where the system was paused. Button #2 pauses

the current timeline indefinitely until the Button #1 is pressed. When paused,

execution of the tilneline is suspended and the current temperature remains constant

within the TES expeNnent cavity. Button #4 returns the user Back to the Program
Menu.
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-:.i-r-..'---..'7 fi.+'-..'-..'-..'-i.4-..'_i-f.4-.-'-..'-..'+"-i+ir;__" "+"mm;r;"+<+==<<+<<++I"+'+-}++;+'--']Y.,-m"+:m+mm"++r'++'+'_:, mmn mr+..,mmmr.,.'m+,+.+i
Y ill:'.: iii i!l'!li!liil l lll !l i ll!!ll ''' :::mm:! !'""--m: .-,;:;:;; ;mq!!.!" ''L'::: m :;: :m i ill I l'| ill i|iiii ill l ill i iiiil!l l llil':ii!!|ill I l';ii| |if!!+ "F:i!iiiiiiilll iii!iii

l:;:;:;l:l l ; lil_:;_;;i l:;;;;:;;;;llilll :++;;il;l I l i:::: l I _;lllilllii;; _ _ :I_ :1: :;: i :: ::: ::: ;!; : :I iiti

llll::tl:ll;l I
l+++l++++l+++7++I

Figure 3.12. Run/Pause Menu

3.4.4 Delete Timeline

Button #3 of the Program Menu (Figure 3.8) allows flae user to delete the current

programmed timeline. Once pressed, the TES system displays 'Deleting Tilneline...'

on the first line of the LCD. The system then deletes the timelhae leavhag an array of
zeroed parameters as follows:

O1 00:00 000.0 O0
02 00:00 000.0 O0

03 00:00 000.0 O0

04 00:00 000.0 O0

05 00:00 000.0 O0

06 00:00 000.0 O0

07 00:00 000.0 O0

08 00:00 000.0 O0

09 00:00 000.0 O0

10 00:00 000.0 O0

Once the system deletes fl_e current thneline profile, the second line of the LCD will

read 'Timeline is Deleted!' acknowledging that all variables have been initialized.

The system fl_en rettm_s to the Program Menu. Figures 3.13 m_d 3.14 show the

delete displays. Once deleted, new timeline programs must be entered via the Edit
Menu.
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i:_:!! :fin::!ii:ii:!::iiii::!!!i!iiii! i3 ii iiiiiiliiiiii!iiiii!!i:'iiiiiii:.;iii'iiii!ii,_i:':!!i!i_||iilii|i!!i!!!i:- !lill : ; : :=::::;;;:;:
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Figure 3.13. Delete Display # 1

::: :::t ;'::l :::;:;:':111:::::::::1:::I 11::"I t, ............................

..................................................................l'"'"'_s..................:'::"::'" _

:_:::_:'::'_';'_::::i:_:_:i:_:::_!_!!_I_:I.:_Iill*_!_iii`:F_F. :l:.;i!i_ll!Fl:,:llllIB,_li_lii|ill

_ ."l:"_:ii_ii,"'_iiii!ill'_ll! I!Iiii-:ii! ii iii!i! 1!i!!! !ii il!'i! !!i!i I_
.... : " ::" :" " .... : i ii i i mf _: .................i!::ii11I__,ttli ............... _ i i_ i_ilii_',.........

i_i: *_li_i;"_, l_l li ;i :;; i;;;i:; lI Ill i; II ill Ill:: I:: Ill :i: ill 1:1lit 11:l.i :'. Ill .ll Ill ill I I*.. i...tl 1t|l]l'_li l_ l: fill: l;:: i l,*;ii: ii: i:i ii Ii i| i

_ _ _"'_!ill i:,F,..,,,1

Figure 3.14. Delete Display #2

3.5 Utility Menu

The Utility Menu (Figure 3.15) allows the user to view system status and

lock/unlock the keypad. Button #1 displays the status of the system. Button #2
locks or unlocks the keypad. Button #4 retunas the operator to the Main Menu.

....... !::::,:_:_:_!_r.,!_TES MOCkup ...........................................:::, :::::::q,li ::: : ::::::::::::::::::::::::::: ........... ............. : :..:,, +.:
:_'t_;I:::!_::iiilIIIIiI!iI:!!!:!!:!.!D.!L.....!..!.....7 ................

I_ _ !!_+:!i!!"rlm"riii_ir"!!i'ii_@:ii-",+"!ii_iiiii+'ilI!im-;-"."iiiiiiil..'i:_:i_!i

Figm'e 3.15. Utility Menu
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3.5.1 System Status

When Button # 1 of the Utility Menu (Figure 3.15) is pressed, the system displays a

series of system checks to the LCD. Each check is displayed for a few seconds mid

then cleared from the display. Four system status checks are displayed which are

the current temperature of the TES, the current mode of execution, communication

status and a character display check (Figures 3.16 - 3.19). After the final status

screen is displayed, the system returns to the Utility Menu.

I_iT_i_i::| ....................:,,,_..IM,,,,M..................!,,,,_,.,,,u,,
p--

r.._. _ N "!:: !!Niii::_:: .ii

Figure 3.16. Current Temperature Status Display

..._ .........L.L.!!!._!!!!!.!!!.ir_!!!!,!!_!_!!i_!!!_,_.!_!!r!_!!TES Mockup !_!_!!!_!_!i_!!!!i!!!_!!!r!!_!!!_!!_!!_!!_._!i!_ii!ii_iii_iiii_i_!

: : : : : : :

........._.ia'..T:...'..Ti_2iF.:.iiiiii_iii:'F.iiiff_:T.;4i_:::::::::,,,:..

Figure 3.17. Current Execution Status

::: ,, ::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::: :::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::

iU.LI _._di, I] _L _l_ll.l_:_ ::'::n: :: ::::::::::: ::::::::::::::":::":::,_:::::.:::::::::::*'::::i: :!:F::*'_I_[_';'" :i:,:;[_*:_.*':",i ;|_

NN N
Figure 3.18. Communication Status
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'iiii...iiiiiN N "__

Figure 3.19. Character Display Status

3.5.2 Lock/Unlock Keypad

Button #2 of the Utility Menu (Figure 3.15) allows the user to lock or mflock the

keypad. Button #2 depressed once locks the menu and twice unlocks the menu.

Once the keypad has been locked, the mockup can be transported without altering

the menu contents, preventing unintentional keypad depressions. The LCD will

display the Utility Menu indefinitely until Button #2 is pressed again to unlock the
keypad.

14



4. Serial Communication

The TES mockup can be operated remotely tlu'ough the RS232 serial

communications port. The remote functions of the TES operates similar to the

fimctions of the four keypad buttons located on the front of the TES mockup. The

flight TES was capable of accepting nine commands or transmitting data via the

RS422 colruntmications port. One of the original commands, 'LOAD', allowed a

prepared timeline to be downloaded serially. The mockup doesn't contain this

feature in its current version. Unlike the flight TES, the mockup's serial protocol

was designed to gain full access of all menus. A few additional features were added

to the serial protocol to anticipate and correct for synchronization errors between

the mockup and the ground station.

4.1 Basic Protocol

All features for serial communication operate similar to the four button switches

located on the front of the Thermal Enclosure System. ASCII 1 - 4 correspond to

Buttons #1 - #4. Instead of pressing Button #1, the user can send an ASCII '1'

tlu'ough the serial port to get the same response. The menu flow will operate to
either input device.

4.2 Additional Features

Additional features have been added for remote control considerations. These

features cover initialization, synchronization, mad audio check feedback. To assist

in these additional features, a command value has been assigned to each software

function. In the case of iifitialization, the system repeatedly sends the co!mnand

value of the TES Display Logo tluough the serial colmmmications port. The
ground station or remote site receives this co_mnand value whenever the TES

software is in this grotmd state. The command value stops transmitting whenever an

input value is received either by one of the four Buttons on the TES front face or an

ASCII equivalent value via the serial port.

A synclu'onization feature was added to prevent asynclu-onous program flows

between the TES mockup and the remote ground station. Whenever a menu is

15



selected, the value of the current menu command value is sent to the

communications port. For example, if the TES mockup has been operating via the

remote station and a break appears in the communications line, the remote station

can restart without affecting the current TES software state. The remote station can

then request the current command value of the mockup. Once received, the ground

station can continue operating the mockup remotely from the current TES software

state. The remote site must send an ASCII '5' to request the current co_mnand value.

To ensure a proper communications link, an audio check feature has been added to

the Utility Menu (Figure 3.5). If the user sends an ASCII '3' to the TES system,

three beeps will sound. This feature was added to provide feedback to the remote

site. The audible sounds indicate that the remote signal was received.
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5. Hardware Diagrams and Connections

This section describes the hardware used in the mockup and the proper wiring
configurations for tile momentary switches.

5.1 DP-31/535 Single Board Computer

Tile DP-31/535 single board computer was used to implement tile TES simulation

software. The board measures 4.125 by 6.5 inches and permits up to 120K Bytes of
EPROM and/or RAM. The microcontroller used is the Siemens 80535. The 80535

provides 256 Bytes of RAM, 8 channel 8 bit A/D Converter, parallel and buffered
serial ports.

5.1.1 Block Diagram

Figure 5.1 provides a block diagram of the DP-31/535.

BANK 0

JonnEgs _U9

tlle.pAOOv
RA_K 1

DAI^ FI|_S

|

Figure 5.1. DP-31/535 Block Diagram
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5.1.2 J5 Connections

Figure 5.2 shows the 50 pin jumper (J5) on the DP-31/535 board and the TES

mockup configuration. Pins 15 and 16 are used for the speaker. Pins 25 - 34 and

pin 36 are used for the LCD. Pins 37 - 40 are used for the four momentary switches

on the front face of file TES mockup.
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Figure 5.2. J5 Comlections
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5.1.3 Momentary Switches

For clarity, the momentary switches are the sameas the buttons. All four buttons or
molnentary switches make up the keypad. Each momentary switch is comlected
normally open (NO). When a button is pressed, a +5 volt signal is sent to the
DP-31\535 microcontroller. Figure 5.3 displays the current wiring coidiguration
used in the TES mockup. Button #1 is connected to pin 38 of the J5 colmector.
Button #2 is connected to pin 37. Button #3 is connected to pin 40. And Button #4
is coImected to pin 39 of the J5 connector. The +5 volt signal is attached to each
button as default. The one +5 volt signal is connected to either pin 49 or pin 50 of
the J5 comaector.

( 58 ) ( 37 ) ( 40 ) ( 39 ) ( 49 ) J5 PIN NUMBER

I NC NO

I I

white orange green block +SV

I
I

I I I I

B#_ B#2 B#3 B#4

NO

BUTTONS

Figure 5.3. J5 Momentary Switches (Buttons)

TOP

VIEW
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5.1.4 Power Requirements

The DP-31/535 system board requires four colmections through the J4 cormector.

Pins I - 4 should be supplied by -12 volts, +12 volts, GND, and +5 volts,
respectively. VAGND, VAREF, and VPD connections are available mid are

optional. Refer to the DP-31/535 Single Board Computer User's Manual for further
information on signal connections.

5.2 LCD Module

The AND591 LCD module was selected for the TES mockup display output. This

compact dot matrix LCD provides a 2 line x 40 characters panel that can display
160 different kinds of alphabets, members, and symbols. The AND591 has built-in

control with display RAM and character generator ROM. It also has the option of
being interfaced to eiflaer a 4 or 8 bit CPU. The dimensions of the LCD module are
as follows:

width

height

depth
The following is

182 mm

33.5 mm

13 mln.

a list of LCD pin connections:

LCD pin # Pin Connection

1 (GND) 3 (J4)

2 (VDD) 4 (J4)

3 (V0) pot (25k olun)

4 (RS) 33 (J5)

5 (R/W) 36 (J5)

6 (E) 34 (J5)

7 (DB0) 31 (J5)

8 (DB1) 32 (J5)

9 (DB2) 29 (J5)

10 (DB3) 30 (J5)

11 (DB4) 27 (J5)

12 (DB5) 28 (J5)

13 (DB6) 25 (J5)

14 (DB7) 26 (J5)
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6. Description of Appendixes

Appendix A contains references related to the flight thermal enclosure system

and hardware used in the simulated mockup. Appendix B contains a list of the

simulation software.

7. Concluding Remarks

This paper describes the operation of the shnulated thermal enclosure system used

in the Intravehicular Automation and Robotics laboratory. The mockup has been

used in tests with an internal telerobotic servicing system to investigate time

required and errors encountered in performing a representative microgravity task.
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Appendix A Related Documents

This section describes the reference manuals used to obtain information on the flight

Thermal Enclosure System control specifications, DP-31/535 Single Board

Computer, the 80535 microprocessor, and the AND591 LCD module.

O Thermal Enclosure System User's Manual

Space h_dustries, Inc.

Webster, Texas

(713) 338-2676

September 1991

O DP-31/535 Sfllgle Board Computer User's Mmmal

Allen Systems

2346 Brandon Road

Columbus, Ohio 43221

(614) 488-7122

November 1, 1986

O Siemens 8-Bit Single Chip Microcontroller Hmadbook

Siemens Components, Inc.

2191 Laurelwood Road

Santa Clara, CA 95054

(408) 980-4500

O The AND591 LCD

AND

770 Airport Boulevard

Burlingame, California 94010

(415) 347-9916
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Appendix B Software Listing

The following software listing was written in the C progranuning language.

Microprocessor specifics are described in the Siemens 8-Bit Single Chip

Microcontroller Handbook.
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/* TES 1.C - code to operate the Thermal Enclosure System (TES).

* This code controls 2 input sources (4 LCD buttons & serial port)

* and 2 output devices (an LCD display & serial port).

* July 1993 - ATM */

#include <stdio.h>

#include <string.h>

#include <ctype.h>

#include <reg515.h>

void

void

void

void

void

void

void

void

void

void

void

void

void

void

void

void

void

int

int

void

void

void

void

void

void

void

initialize();

display_onO;

display off0;

cursor_onO;

cursor_off();

clearLCD0;

position_cursor0;

position( int line, int pos );

Iinel0;

line20;

send_char( char letter );

send_line( char *string );

clearlinel ();

clearline20;

pause();

wait();

debounce( int num );

buttons( int menu );

buttons_wait( int menu );

send_menu( int menu );

shift_display_lefL0;

shift_display_fight();

float to string( float hum, char *fstring );

num to string( int num, int digits, char *nstring );

time to string( int num, char *tstring );

speaker_soundO;

/* global variable for serial comm */

int external_input = 0;

main()

{
int loop,get_key,value,line,pos, curaddress, ii,charhex,check;

int button,command, num,thermistor[9],SR[ 10],SEQ[10],TIME[ 10];

int tX, tX_OLD,tnum,a,b,var, mode,lock;
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float temperature[10];
charstring[40],fstring[4],nstring[2],status_string[3],BF[6],letter;
charsstring[3],tstring[5],mstring[7];

SCON= 0x52; /* setup serial port control */

PCON &= 0x7F; /* clear SMOD */

BD = 1; /* use internal baud rate generator */
based on: baud rate = 2^SMOD/2500 *

clock_frequency
= 2^0/2500 * 12e6

= 4800 */

ES = l; /* enable serial interrupt */

EAL = 1; /* enable all interrupts */

loop -- 1; /* initialize while ( loop = 1 )

strcpy( string," ");

*/

initialize0;

command = 1;

get_key = 0;

/* initialize LCD */

/* TES variables */

for( tnum= 1;tnum<= 10;tnum=tnum+ 1 )

thermistor[tnum] = 0;

tnum = 1,

for( b=0;b<=l 1;b=b+l )

{
SEQ[b] = b; /* sequence # */

TIME[b] = 0; /* minutes */

temperature[b] = 0.0; /* temperature */

SR[b] = 0; /* samples/sec */

SEQ[1] = 1;

TIME[I] = 90;

temperature[l] = 123.4;

SR[1] = 10;

b=l;

tX= 1;

tX_OLD = 1;

var = 1; /* edit time variable */

lock = 0;

25



while(loop)

switch(command)
{

case l: /******* TESINTRO *********/

cursoroff0;

linel0;

get_key = 0;

strcpy( string," Thermal Enclosure System (TES)

send_line( string );

line2();

strcpy( string," NASA LaRC " );

send_line( string );

" );

/*debounce( 5 );*/

wait();

P5 =0x00;

while( get_key _ 0 )/* shift left and look for key input */
{

shift_display_left();

for( ii=0; ii<3; ii++ )/* approx 2.5 sec wait loop */

{
get_key = buttons( command );

if( get_key _ 5 ) get_key = 0;

if( get_key 7= 0 ) ii=100;

wait0;

command = 2;

/*debounce( 1 );*/

break;

case 2:

clearLCD0;

linel0;

strcpy( string,"

send_line( string );

line20;

/******* MAIN MENU

MAINMZN-O ");

26



strcpy(string,"1) Set

send_line( string );

get_key = 0;

2) Program 3) Utility 4) Logo ");

/*debounce( 1 );*/

wait0;

get_key = buttons_wait( command );

if( get_keel )

if( get_ke_2 )

if( get_key==3 )

if( get_key==4 )

if( get_ke_5 )

command = 3; /* Set Menu */

command = 7; /* Program Menu */

command = 1 I; /* Utility Menu */

command= 1; /*Logo */

command = 2;

/*debounce( 1 );*/

wait0;

break;

case 3: /******* SET MENU *********/

clearLCD0;

linel0;

strcpy( string," SET MENU " );

send_line( string );

line20;

strcpy(string,"l) Temp 2) Therm 3) Sample Rate 4) Main " );

send_line( string );

get_key = 0;

get_key = buttons_wait( command );

if( get_keel ) command = 4; /* Set Temp */
if( get_ke_-=2 ) command = 5; /* Set Therms */

if( get_ke_3 ) command = 6; /* Set SR */

if( get_ke_4 ) command = 2; /* Main Menu */

if( get_ke_5 ) command = 3;

/*debounce( 1 );*/

wait0;

break;

case 4: /***

strcpy( fstring,"

clearLCD0;

linel0;

strcpy( string,"

Set Temperature MENU

" );

Set Temperature
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send_line(string);
line2();
strcpy(string,"l) + 2) - 3) X/.X 4) Back

send_line( string );

position( 2, 34 );

float to string( temperature[b], fstring );

send_line( fstring );

strcpy( fstring," " );

get_key = 0;

TEMP- ");

get_key = buttons_wait( command );

if( get_key-==l ) /* Increment Temperature */
(

if( tX = 1 )

temperature[b] = temperature[b] + 1.0;

if( tX = 0 )

temperature[b] = temperature[b] + 0.1;

if( temperature[b] > 999.9 )

temperature[b] = 999.9;

command = 4;

}
if( get_key---=2 ) /* Decrement Temperature */

{
if( tx = 1)

temperature[b] = temperature[b] - 1.0;

if( tX = 0 )

temperature[b] = temperature[b] - 0.1;

if( temperature[b] < 0.0 )

temperature[b] = 0.0;

command = 4;

}
if( get_key--=3 ) /* Select l's or. l's */

{
tX_OLD = tX;

if( tX_OLD = 1 )

tX = 0;

if( tX_OLD r= 1 )

tX= 1;

command = 4;

/*for(ii=0;ii<3;ii=ii+l)*/

wait();

}
if( get_key--=-4 )

{
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command= 3; /* Set Menu */

debounce( 1 );

}
if( get_ke_5 ) command = 4;

/*wait();*/

break;

case 5: /*** Set Thermistors MENU ***/

strcpy( nstring," ");

clearLCD0;

linel0;

strcpy( string," Select Thermistors: # Status: " );

send_line( string );

line20;

strcpy(string,"l) Thermistor # 2) ON/OFF 4) Back " );

sendJine( string );

position( 1, 23 );

num to string( tnum, 2, nstring );

send_line( nstring );

/*printf("_tnum = %d tnum nstring = %s_a",tnum,nstring);*/

strcpy( nstring," ");

position( 1, 36 );

if( thermistor[tnum] ---_ 1 )

strcpy( status_string,"ON ");
else

strcpy( status_string,"OFF" );

/*printf("thermistor[%d] = %d

%skn_",tnum,thermistor[tnum],status_string);*/

send_line( status_string );

strcpy( status_string," " );

status =

get_key = 0;

get_key = buttons_wait( command );

if( get_keel ) /* Select Next Thermistor

{
tnum = tnum + 1;

if( tnum > 10 )

tnum = 1;

*/
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/* print f("get_key= 1:

command = 5;

/*wait0;*/

new tnum = %d_n",tnum);*/

}
if( get_kew2 ) /* Turn Thermistor ON/OFF */

(
a = thermistor[tnum];

/*printf("get_key=2: a = %d

%dLq",a,tnum, thermistor[tnum]);*/

if(a_ 1)

thermistor[tnum] = 0;

iffa--=-0)

thermistor[tnum] = 1;

/*printf("get_key=2: a = %d

%d_n",a,tnum,thermistor[tnum]);*/

command = 5;

/*for(ii=0;ii<3;ii=ii+l)*/

wait();

}
if( get_ke_4 )

{
command = 3; /* Set Menu */

debounce( 1 );

}
if( get_ke_5 ) command = 5;

old thermistor[%d] =

new thermistor[%d] =

/*wait();*/

break;

case 6: /***

/*strcpy( sstring,"

clearLCD0;

linel0;

strcpy( string,"

send_line( string );

line20;

strcpy(string,"i) + 2) - 4) Back

send_line( string );

position( 2, 34 );

num to string( SR[b], 3, nstring );

send_line( nstring );

/*strcpy( sstring," " );*/

get_key = 0;

Set Sample Rate MENU ***/

,, );,/

Set Sample Rate " );

SAMPLE RATE: ");

get_key = buttons_wait( command );
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if( get_keel ) /* Increment SR

{
SR[b] = SR[b] + 1;

*/

if( SR[b] > 999 )

SR[b] = 999;

command = 6;

/
if( get_ke_2 ) /* Decrement SR

{
SR[b] = SR[b] - 1;

*/

if( SR[b] < 0 )

SR[b] = 0;

command = 6;

}
if( get_ke_4 )

{
command = 3; /* Set Menu */

debounce( 1 );

}
if( get_ke_5 ) command = 6;

/*wait0;*/

break;

case 7: /******* PROGRAM?MENU

clear_LCD0;

line10;

strcpy( string," PROGRAM MENU

send_line( string );

line20;

strcpy( string," 1) View 2) Run/Pause 3) Delete

send_line( string );

get_key = 0;

__/

" );

4) Main " );

get_key = buttons_wait( command );

if( get_keel )

if( get_ke_2 )

if( get_ke_3 )

if( get_ke_4 )

if( get_ke_5 )

command = 8;

command = 10;

command = 13;

command = 2;

command = 7;

/* View Menu */

/* Run/Pause */

/* Delete */

/* Main Menu */
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/*debounce( 1 );*/

wait0;

break;

case8: /*** VIEWMENU ***/

strcpy( nstring," " );

strcpy( fstring," " );

strcpy( tstring," " );

clear_LCD0;

linel0;

strcpy( string,"VIEW: S T TEMP

send_line( string );

line20;

strcpy(string,"l) + 2) - 3) Edit 4) Back

sendJine( string );

position( 1, 7 );

num to string( SEQ[b], 2, nstring );

send_line( nstring );

strcpy( nstring," " );

position( 1, 13 );

time to string( TIME[b], tstring );

send_line( tstring );

strcpy( tstring," " );

position( 1, 25 );

float to string( temperature[b], fstring );

send_line( fstring );

strcpy( fstring," " );

position( 1, 35 );

hum to string( SR[b], 2, nstring );

send_line( nstring );

strcpy( nstring," " );

SR " );

" );

get_key = 0;

get_key = buttons_wait( command );

if( get_ke_--=l ) /* Select Next Timeline Sequence */

b=b+l;
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if(b> 10)
b = 10;

command = 8;

}
if( get_ke_2 )

{
b=b-1;

if(b< 1)

b=l;

command = 8;

}
if( get_ke_3 )

{
command = 9;

}
if( get_key==4 )

{
command = 7;

}
if( get_key---=5 )

/* Select Previous Timeline Sequence */

/* Edit Menu */

/* Program Menu */

command = 8;

/*wait0;*/

break;

case 9:

strcpy( nstring," " );

strcpy( fstring," " );

strcpy( tstring," ");

clearLCD0;

linel0;

strcpy( string,"EDIT: S

send_line( string );

line20;

strcpy( string,"EDIT:

send_line( string );

/*** EDIT MENU ***/

T TEMP SR ");

1) + 2)- 3) X/.X 4) Next" );

position( 1, 7 );

num to string( SEQ[b], 2, nstring );

send_line( nstring );

strcpy( nstring," " );

position( 1, 13 );

time to string( TIME[b], tstring );

send_line( tstring );

strcpy( tstring," ");
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position(1,25 );
float to string(temperature[b],fstring);
send_line(fstring);
strcpy(fstring," " );

position(1,35);
num to string(SR[b],2, nstring);
send_line(nstring);
strcpy(nstring," " );

if( var== 1) /* edit time */

{
position( 2, 8 );

strcpy( tstring,"TIME" );

send_line( t string );

strcpy(tstfing," " );

if( var _--- 2 ) /* edit temp */

{
position( 2, 8 );

strcpy( tstring,"TEMP" );

send_line( tstring );

strcpy(tstring," ");

if( var == 3 ) /* edit sample rate */

(
position( 2, 8 );

strcpy( tstring,"RATE" );

send_line( tstring );

strcpy( tstring," ");

}

get_key = 0;

get_key = buttons_wait( command );

/*printf("h'tEDIT: var = %d get_key = %dkn",var, get_key);*/

if( get_kew1 ) /* Increment variable */

{
if( var _ 1 ) /* incr time */

{
TIME[b] = TIME[b] + 1;
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if( TIME[b] > 5999)
TIME[b] = 5999;

if( var_ 2)
(

/* incr temp */

if( tX == 1 )

temperature[b] = temperature[b] + 1.0;

if( tX == 0 )

temperature[b] = temperature[b] + 0.1;

if( temperature[b] > 999.9 )

temperature[b] = 999.9;

if( var _ 3 ) /* incr sr */

{
SR[b] = SR[b] + 1;

if( SR[b] > 999 )

SR[b] = 999;

command = 9;

}
if( get_key'-_2 )

{
if( var _ 1 )

{

/* Decrement variable */

/* decr time */

TIME[b] = TIME[b]- 1;

if( TIME[b] < 0 )

TIM]E[b] = 0;

if( var _ 2 )

(
/* decr temp */

if( tX-- 1 )

temperature[b] = temperature[b] - 1.0;

if( tX = 0 )

temperature[b] = temperature[b] - 0.1;

if( temperature[b] < 0.0 )

temperature[b] = 0.0;

if( var = 3 ) /* decr sr */

{
SR[b] = SR[b] - 1;
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if( SR[b]< 0 )
SR[b]= O;

command = 9;

if( get_ke_3 )

{
tX_OLD = tX;

if( tX_OLD = 1 )

tX = 0;

if( tX_OLD != 1 )

tX= 1;

command = 9;

/*for(ii=0;ii<3;ii=ii+l)*/

wait0;

if( get_ke_4 )

{

/* Select l's or .l's */

/*printf("EDIT: get_key = 4 (before incr) var= %d_n",var);*/

var = var + 1;

/*printf("EDIT: get_key = 4 (after incr) var = %d_",var); */

command = 9;

if( var _-- 4 )

{
var = 1;

command = 8; /* View Menu */

/
debounce( 1 );

if( get_ke_5 ) command = 9;

/*wait();*/

break;

case 10: /******* Run/PauseMENU

strcpy( mstring," " );

clearLCD0;

linei0;

strcpy( string," Run/Pause Menu

send_line( string );

line20;

strcpy( string," 1) Run 2) Pause 4) Back STATUS:

send_line( string );

****+****/

" )_

");
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get_key= 0;
position(2, 33 );
if( mode_ 1)

strcpy(mstring,"RUNNING");
else
strcpy(mstring,"PAUSED" );

send_line(mstring);

get_key= buttons_wait( command );

if( get_ke_-=l ) /* Select Run Mode */

{
mode = 1;

command = 10;

/* for(ii=0;ii<3 ;ii=ii+ 1)*/

wait();

}
if( get_key==2 )

{
/* Select Pause Mode */

mode = 0;

command = 10;

/* for(ii=0;ii<3 ;ii=ii+ 1)* /

wait0;

if( get_key==4 )

{
command = 7;

debounce( 1 );

}
if( get_key==5 ) command = 10;

/*debounce( 1 );*/

/*wait();*/

break;

case ll: /******* UTILITY MENU *********/

clear_LCD0;

linel0;

strcpy( string," UTILITY MENU " );

send_line( string );

line20;

strcpy( string," 1) Status 2) Lock/Unlock Keypad 4) Main " );

send_line( string );

get_key = 0;
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get_key= buttons_wait(command);

if( get_keel )
if( get_ke_2 )
(

a = lock;

if(a-=l)

lock=0;

if(a=0)

lock= 1;

command = 12; /* Status

/* Lock/Unlock */

*/

while( lock = 1 )

{
debounce( 1 );

get_key = buttons_wait( command );

if( get_ke_2 )

lock=O;

command = 11;

}
if( get_key==3 )

{
speakersound0;

command = 11;

if( get_key==4 )

if( get_ke_5 )

command = 2; /* Main Menu */

command = 11;

/*debounce( 1 );*/

wait0;

break;

case 12:

strcpy( fstring,"

strcpy( mstring,"

clearLCD0;

linel0;

strcpy( string,"

send_line( string );

line2();

strcpy( string,"

send_line( string );

position( 2, 34 );
float to

" );

" );

Status Displays

TES Status

_**_*_/

Temperature TEMP:

string( temperature[b], fstring );

" );

" );
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send_line(fstring);
strcpy(fstring," " );
for(ii=0;ii<3;ii=ii+1)

wait0;

line20;
strcpy(string,"............ProgramTimelineis
send_line(string);
get_key= 0;
position(2, 33 );
if( mode== 1)

strcpy(mstring,"RUNNING");
else
strcpy(mstring,"PAUSED" );

send_line(mstring);
for(ii=0;ii<3;ii=ii+1)

wait0;

" );

line20;
strcpy(string,"Communications........................" );
send_line(string);
for(ii=0;ii<3;ii=ii+1)

wait0;

line20;
strcpy(string,"1234567890123456789012345678901234567890");
send_line(string);
for(ii=0;ii<3;ii=ii+1)

wait0;

command= 11;
break;

/* Utility Menu */

case 13:

clearLCD0;

linel0;

strcpy( string,"

send_line( string );

for(ii=0;ii<3 ;ii=ii+ 1)

wait();

/******* Delete Timeline

Deleting Timeline ..... " );

for( b=0;b<=l 1;b=b+l )

{
SEQ[b] = b; /* sequence # */

TIME[b] = 0; /* minutes */
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temperature[b]= O.Q
SR[b]= O;

}
b=l;

SEQ[1] = 1;

temperature[ 1] = 0.0;

tX = 1;

tX OLD = 1;

var = 1; /* edit time variable */

/* temperature */

/* samples/see */

line20;

strcpy( string,"

send_line( string );

for(ii=0;ii<3 ;ii=ii+ 1)

wait();

Timeline is DeletedT ");

command = 7;

break;

/* Program Menu */

default:

clear_LCD0;

linel0;

strcpy( string," This functions not yet implementedT " );

send_line( string );

line20;

strcpy( string," Press a key to return to the Main Menu " );

send_line( string );

get_key = 0;

get_key = buttons_wait( command );

command = 2; /* Main Menu */

/*debounce( 2 );*/

wait0;

break;

} /* end of switch statement */

/* end of while loop */

/* end of main */
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void pause(void )

char ret;

printf("Hit Returnto Step!_");

scanf("%c",&ret);

void wait(void )

int n, nmax;

n = 0;

nmax = 1000;

while( n<nmax ){ n++; }

void debounce( int num)

int ii,iimax;

/* debounce wait function */

/*iimax =num * 20;*/

iimax = 0;

for( ii=0; ii<iimax; ii++ )

{
wait();

}

void initialize( void )

P4 = 0x38; /* function set = 2 lines,5X7 dots, 8 bit */
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P5= 0x01;
P5= 0x00;
wait0;
P4= 0x0E;
P5-- 0x01;
P5= 0x00;

/* enable = 1 */

/* enable -- 0 (clocked) */

/* turn display on, cursor on
/* enable = 1 */

/* enable = 0 (clocked) */

/*printf("ha<<< LCD initialized f >>>ha");*/

*/

void

{
display_on( void )

P4 = 0x0E; /* turn display on, cursor on

P5 = 0x01; /* enable = 1 */

P5 = 0x00, /* enable = 0 (clocked) */

*/

void

{
display_off( void )

P4 = 0x08;

P5 = 0x01;

P5 = 0x00;

/* turn display off, cursor off */

/* enable = 1 */

/* enable = 0 (clocked) */

void

{
cursoron( void )

P4 = 0x0E; /* turn display on, cursor on

P5 = 0x01; /* enable = 1 */

P5 = 0x00; /* enable = 0 (clocked) */

*/

void cursoroff( void )

P4 = 0x0C;

P5 = 0x01;

P5 = 0x00;

/* turn display on, cursor off */
/* enable = 1 */

/* enable = 0 (clocked) */
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void clear_LCD(void )

P4= 0x01;
P5= 0x01;
P5= 0x00;
/*printff"ha<<<LCD cleared! >>>ha");*/

void

(
position_cursor( void )

int line,pos,curaddress;

printf("_tLine < 1 > or Line < 2 >? >> ");

scanf("%d",&line);

printf("haCharacter position < 0 - 39 >? >> ");

scanf("%d",&pos);

printf("h'tLine = %d Position = %dha",line,pos);

position( line, pos );

/*cur_address = 0x80;

if( line_--- 1 )

curaddress = cur_address + 0x00;

else if( line_--_-2 )

curaddress = curaddress + 0x40;

curaddress = cur_address + pos;

/*printf("haCursor address = %#xha",curaddress);*/
P4 = curaddress;

P5 = 0x01;

P5 = 0x00;

/*printf("ha<<< Cursor positioned! >>>ha");*/

void

{
position( int line, int pos )

int curaddress;

curaddress = 0x80;

if( line--=l )

curaddress = curaddress + 0x00;

else if( line_2 )
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cur_address= cur_address + Ox40;

curaddress = cur_address + pos;

P4 = cur_address;

P5 = OxO1;

P5 = OxO0;

void linel(void)

{
int cur_address;

cur_address = Ox80;

P4 = cur_address;

P5 = OxO1,

P5 = OxO0;

/*printf("ha<<< Cursor positioned at linel T>>>ha");*/

void line2( void )

{
int cur_address;

curaddress = Ox80 + Ox40;

P4 = curaddress;

P5 = OxO 1;

P5 = OxO0;

/*printf("ha<<< Cursor positioned at line2Y >>>ha");*/

void

{
send_char( char letter )

/*wait();*/

P4 = (int) letter;

P5 = Ox03;

P5 = Ox02;

/*printf("P4 = %#xkn",P4);*/

/*printf("ha<<< Character Sent! >>>ha");*/
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void
{

send_line( char *string )

int check,ii,iimax;

iimax=3 9;

for( ii=O;ii<=iimax;ii++ )

(
check = iscntrl( string[ii] );

if( check _-- 0 )

send_char( string[ii] );
else

11= nmax+ 1;

/*printf('%aknCharacter = %c DEC value = %i HEX value = %#xkn"

,string[ii],string[ii],string[ii]);*/

}
strcpy( string," " );

void clearlinel( void )

{
int check,ii,iimax;

char clrstring[40];

linel0;

strcpy( clrstring," " );

for( ii=0;ii<=39;ii++ )

{
send_char( clrstring[ii] );

}
strcpy( clrstring," " );

linel0;

void clear_line2( void )

{
int check,ii,iimax;

char clrstring[40];
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line20;
strcpy(clrstring," " );
for( ii=O;ii<=39;ii++)
{

send_char( clrstring[ii] );

}
strcpy( clrstring," " );

line20;

int

(
buttons( int menu )

extern int external_input;

int button;

char nstring[2];

/* output of command menu # for external source */

strcpy( nstring," " );

hum to string( menu, 2, nstring );

putchar( nstring[O] );

putchar( nstring[ 1] );

button = O;

P5 = OxO0;

if((P5&OxlO) > 0 )

if((vs&ox2o) > o )

if((PS&Ox40) > 0 )

if((PS&Ox80) > 0 )

if((button<l)H(button>4))

button = 1;

button = 2;

button = 3;

button = 4;

button = O;

if( external_input _ 1 )

if( external_input _ 2 )

button = 1;

button = 2;
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if( external_input_ 3 ) button= 3;

if( external_input -- 4 ) button = 4;

if( external_input _ 5 ) button = 5;

if((button<l)ll(button>5)) button = O;

external_input = O;

return( button );

int

{
buttons_wait( int menu )

extem int external_input;

int hit,button;

char nstring[2];

/* output of command menu # for external source */

strcpy( nstring," " );

num to string( menu, 2, nstring );

putchar( nstring[O] );

putchar( nstring[ 1] );

hit= 1;

while( hit )

{
/* get external input, i.e. macintosh, pc, etc. */

if( external_input == 1 )

(
button = 1;

hit = O;

}
if( external_input _ 2 )

button = 2;

hit = O;

}
if( external_input -- 3 )

(
button = 3;
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hit = O;

}
if( external_input _ 4 )

{
button = 4;

hit = O;

}
if( external_input _ 5 )

button = 5;

hit = O;

}

/* get input from LCD momentary switches */

P5 = 0x00;

if((P5&0xl0) > 0 )

{
button = 1;

hit = 0;

putchar( 0x30 + button );

}
if(fpS&Ox2O)> o )
{

button = 2;

hit = 0;

putchar( 0x30 + button );

}
if((P5&0x40) > 0 )

{
button = 3;

hit = 0;

putchar( 0x30 + button );

}
if((P5&0x80) > 0 )

{
button = 4;

hit = 0;

putchar( 0x30 + button );

}
}
/*printf("kn<<< LCD button #%d detectedf >>>ha",button);*/

external_input = 0;

return( button );
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void
{

send_menu( int menu )

extern int external_input;

char nstring[2];

/* output of command menu # for external source */

strcpy( nstring," " );

num to string( menu, 2, nstring );

putchar( nstring[O] );

putchar( nstring[ 1] );

void

{
shift_display left( void )

P4 = OxlS;

P5 = Ox01;

P5 = OxO0;

/* shift display 1 position to the left */
/* enable = 1 */

/* enable = 0 (clocked) */

void shift_display_right( void )

P4 = OxlC; /* shift display 1 position to the fight */
P5 = OxO 1; /* enable = 1 */

P5 = OxO0; /* enable = 0 (clocked) */

void

{
float to string( float num, char *fstring )

int value, hvalue,tvalue,ovalue,dvalue;

float temp,temp 1,temp2,temp3;

/* to get the hundred digit value */

temp = num/lO0.O;

hvalue = temp;
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fstfing[O]= (char) (Ox30 + hvalue);

/* to get the ten digit value */

templ= num - hvalue* 100.0;

tvalue = temp 1/10. O;

fstring[ 1] = (char) (Ox30 + tvalue);

/* to get the one digit value */

temp2 = temp 1 - tvalue* 10.0;

ovalue = temp2;

fstring[2] = (char) (0x30 + ovalue);

/* to get the decimal point */

fstring[3] = 0x2E;

/* to get the tenth digit value */

temp3 = temp2 - ovalue;

dvalue = temp3* 10.0;

fstring[4] = (char) (Ox30 + dvalue);

/* to set the null character to denote end of string */

fstring[5] = (char) OxO0;

void

(
num to string( int num, int digits, char *nstring )

int hun,ten, one;

/* to get the hundred digit value */

hun = num/lO0.O;

nstring[digits - 3] = (char) (Ox30 + hun);

/* to get the ten digit value */

ten = (hum - hun* 100)/10.0;

nstring[digits - 2] = (char) (Ox30 + ten);

/* to get the one digit value */

one =num - hun* 100 - ten* 10.0;

nstring[digits -1] = (char) (0x30 + one);

/* to set the null character to denote end of string */
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nstring[digits]= (char) OxO0;

void

{
time to string( int num, char *tstring )

int hr, min, hr 1digit,hr2digit,min 1digit,min2digit;

/* to get the hour and minute values */

hr = num/60.O;

min = hum - hr*60;

/* to get the first hour digit */

hrldigit = hr/lO.O;

tstring[O] = (char) (Ox30 + hrldigit);

/* to get the second hour digit */

hr2digit = hr - hrldigit* 10;

tstring[1 ] = (char) (Ox30 + hr2digit);

/* to get the colon (:) */

tstring[2] = 0x3A;

/* to get the first minute digit */

minl digit = rain/10.0;

tstring[3] = (char) (Ox30 + minldigit);

/* to get the second minute digit */

min2digit -- min - minldigit* 10;

tstring[4] = (char) (Ox30 + min2digit);

/* to set the null character to denote end of string */

tstring[5] = (char) OxO0;

void speakersound( void )

(
int ii,

/* turn speaker on and off three times approx. 1 sec in length */
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P1= OxO1; /* speaker on */

wait();

P1 = OxO0; /* speaker off*/

wait();

P 1 = OxO1; /* speaker on */

waitO;

P 1 = OxO0; /* speaker off */

wait();

P 1 = OxO1; /* speaker on */

wait();

P1 = OxO0; /* speaker off*/

void

{
serial_communication( void ) interrupt 4 using 1

extern int external_input;

char buffer[ 1O];

if(RI)
{

/* tests receive interrupt flag (page 7-42) */

buffer[O] = getcharO;

/*printf("ha****** serial_commfn ******ha");

printf("%c",buffer[O]);*/

if( buffer[O] -_- '1')

external_input = 1;

if( buffer[O] = '2' )

external_input = 2;

if( buffer[O] = '3')

external_input = 3;

if( buffer[O] == '4')

external_input = 4;

if( buffer[O] = '5' )

external_input = 5;

/*printf(" external input = %dha",external_input);

printf("******************************ha");*/
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